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Photo ID Requirements List 
The hardware, software, and licenses required for IEI eMerge™ Photo ID features are listed 
below. In addition to the listed items, you will need to have a login username and password to the 
Network Controller with setup privileges. 

NOTE: Magnetic stripe encoding is supported only in V3.3 build 344 and above of the 
eMerge software. 

Hardware 
At this release, the Photo ID feature is tested to work with the following devices: 

• PC:  A personal computer running Windows XP Pro (Logitech or Canon 
Cameras) or Windows Vista (Logitech cameras only), to be used as 
enrollment/badging station. You will need an administrative account on the 
PC to install software.  

• Cameras: Logitech® QuickCam® Orbit AF camera, and the other compatible and 
tested cameras listed on the following web page: 
http://www.iwsinc.com/Support/EPISuite_compatible_hardware.cfm?Device
=Image%20Capture 

• Printers:  (optional) For a list of the compatible and tested printers, refer to the 
following web page: 
http://www.iwsinc.com/Support/EPISuite_compatible_hardware.cfm. 

• Badges: (optional) Blank photo ID badges. 

Software and Licenses 
 

• License file: To verify that your system has a license file for the Photo ID features, select 
Support : Utility : About, and look for the line “Badge” in the License 
section. If that line does not appear in the list of licenses, contact Linear 
Technical Services at (800) 421-1587 to upgrade your license file. 

• IWS™ software: The IWS™ EPI Builder runtime software and EPI Builder Designer 
software, available by purchase from IEI. This software is necessary for 
creating badge designs. 

• Browser:  Internet Explorer 6 or higher is needed because of the use of an Active X 
component. 

• AF software: If you are using a Logitech QuickCam camera, the Logitech QuickCam 
Orbit AF (autofocus) software, which is provided on the CD with your 
camera. 

http://www.iwsinc.com/Support/EPISuite_compatible_hardware.cfm?Device=Image%20Capture�
http://www.iwsinc.com/Support/EPISuite_compatible_hardware.cfm?Device=Image%20Capture�
http://www.iwsinc.com/Support/EPISuite_compatible_hardware.cfm�
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Setting Up the Photo ID Features 
This section provides Photo ID setup procedures for Logitech cameras and Canon cameras. 

Setup Procedure 
Install the IWS software and IEI Add-on software components on the PC: 

1. If you are a certified systems integrator, call Linear Technical Services at 
(800) 421-1587 for the IEI_PhotoID.zip file. 

NOTE: The software in the IEI_PhotoID.zip file is compatible with eMerge software 
version 3.2 or higher. To check your version number in the Security Application, select 
Support/Utility : About to display the About page. If your version number is lower 
than 3.2, contact Linear Technical Services at (800) 421-1587 for the files needed to 
update your system version. 

2. Unzip the file you downloaded at step 1 onto your local hard drive. Inside the folder 
IEI_PhotoID folder, you will find the following three folders: 

• 1-Designer_Runtime 

• 2-IEI_Add_on 

• 3-Canon Digital Cameras 

3. Open the 1-Designer_Runtime folder and double-click the setup.exe. Follow the 
screen prompts to complete this installation. You must accept the license agreement 
in order to install. 

4. Open the 2-IEI_Add_on folder and double-click the file setup.exe. Follow the screen 
prompts to complete this installation. 

Complete the Logitech camera setup: 

Refer to the camera documentation and complete the software installation and physical setup 
and connection of the Logitech QuickCam camera. 

Complete the Canon camera setup: 

1. Open the Canon Digital Cameras folder and double-click the setup.exe. Follow the 
screen prompts to complete the installation. You must accept the license agreement 
in order to install. 

2. When you reach the InstallShield Wizard Completed dialog, uncheck the box 
labeled Launch EPI Client License Manager now and then click Finish. 

If you do not uncheck the box, a license activation dialog will open. Click Exit. 

NOTE: It is not necessary to install the Canon camera utilities on the PC. The IWS 
Canon Plug-in will provide sufficient function for creating photo IDs. 

3. Refer to the camera documentation and complete the physical setup and connection 
of the camera. 

4. Set the camera shooting mode dial to AUTO. 

5. Slide the camera mode switch to Playback (or Preview) mode. 
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Designing and Uploading Photo ID Badge Layouts 
Design and Upload Photo ID Badge Layouts: 

1. Using EPI Designer and data from the personal information records in your eMerge, 
create a photo ID badge layout and save it.  

NOTE: To start EPI Designer select from the Start menu, Programs : EPI Builder 
Runtime 6 : EPIDesigner. 

See “System Data for Photo ID Badge Layouts” on page 5 for a list of the data fields 
from the personal information records that you can use in your badge design, and for 
assistance including user photos and signatures. Refer to the EPI Designer 
documentation for help working with EPI Designer. 

2. Select Administration : Utility: Photo ID Layout Upload. 

3. Click the Browse button to browse to the location of your photo ID layout files. 

4. In the Browse dialog box select the photo ID layout file you want to upload and click 
Open. 

NOTE: Photo ID badge layout files must end with the .dgn extension and can be no 
larger than 15 MB. If you have layouts from previous versions of EPI Designer, they 
can be opened and saved with the current version as “dgn” files. 

5. Click Save. 

System Data for Photo ID Badge Layouts 
Using EPI Designer, you can create your own custom photo ID badge layouts.  

Selected data fields from the Personal Information page can be used as dynamic fields in the 
photo ID badge layout. The contents of those data fields will print on the badge when it is printed. 

Data fields that may be used for dynamic fields in the photo ID layout using EPI Designer are: 

• First_Name 

• Middle_Name  

• Last_Name  

• U_Field1 through U_Field 5 (user-defined sections) 

• U_Field6 through U_Field20 

• NOTE: User-defined fields 6 through 20 are supported only in V3.3 build 344 and above 
of the eMerge software. 

• Company_ID (ID#) 

• User_Note 

• Badge_Name (photo ID layout name) 

• Start_Date 

• End_Date  



__________________________________________________________________________________________ 
The information in this document pertains to Versions 3.2 and 3.3 of the IEI eMerge software. 
 
 6 

 

• cardid 

• facilitycode 

• NOTE: The cardid and facilitycode fields are supported only in V3.3 build 344 and above 
of the eMerge software. 

 
In addition to the data fields above, you can include a user photo and a signature image on your 
badge designs. You can also encode magnetic stripe badges in V3.3 build 344 and above of the 
eMerge software. 

To include user photos and signature images in your badge design: 

1. Create a “PhotoID” image type. See View : Image Setup in EPI Designer. 

2. Create a “Signature” image type. See View : Image Setup in EPI Designer. 

NOTE: You must create the PhotoID image type first and then the Signature image 
type. This is because the image type index numbers are hard-coded in this feature. 

3. Select Draw : Dynamic Image and add a dynamic image for the photo ID to the 
badge design and set its Image Type to PhotoID. Leave the Field Name blank. 

4. Select Draw : Dynamic Image and add a dynamic image for the signature to the 
badge design and set its Image Type to Signature. Leave the Field Name blank. 

5. Confirm that the badge layout shows “PhotoID” and “Signature” in the middle of the 
image locations in the badge design. 

NOTE: For further instructions on including signatures on badges see Tech Note 11, 
“Configuring the Topaz Signature Pad.” This is available in Help. From the Contents 
page click the link for Technical Documentation. 

6. Complete your badge design and save it. 

For specific information on working with EPI Designer and designing badge layouts, refer to the 
EPI Designer documentation. 
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Creating Photo ID Badges 
This section describes how to create photo ID badges in the Security Application.  

 
NOTE: For information on encoding magnetic stripe cards, see page 9. 

Create a photo ID badge: 

NOTE: If you are using a Logitech QuickCam camera, make sure that the QuickCam 
settings are set to an image size of no more than 640x480, and that Face Tracking is set 
to Follow Me. This will ensure that the image size remains under the maximum 80K. 

1. Select Administration : People. 

2. Add a new person to the system or search for an existing person. 

3. Click the Photo ID tab. 

4. Select from the Badge drop-down the badge design you wish to use. 

5. Click the Photo ID button to display the Photo IDs pop-up window. 

NOTE: If the window does not appear, turn off the pop-up blocker or add the Network 
Controller site to the allowed site list. 

6. In the Photo IDs window, click Capture Image to display the Select Image Source 
window. 

7. Select the appropriate image source for your camera. 

For example, select Microsoft WDM Image Capture (Win32) if you are using a 
Logitech camera, or select Canon Live Capture if you are using a Canon camera. 

8. Click OK to display the Capture window for your camera. 

9. Ensure that the person is properly within the picture frame and is at least six feet away 
from the camera, and then click the capture button.  

10. Click OK. 

11. The Capture window closes and the Photo IDs window redisplays with the image 
placed in the badge design. Confirm that the person’s image is correctly captured and 
click Save Image. 

12. The captured image appears on the Personal Information page. Click the Close 
button in the Photo IDs window. 

13. Scroll to the bottom of the Personal Information page and click Save. 

NOTE: On the Personal Information page, you can right-click on the image and 
select Save Picture as. You can then save this image separately as a jpg or bmp file. 
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Printing Photo ID Badges 
This section describes how to print photo ID badges in the Security Application.  

 
NOTE: For information on printing magnetic stripe encoded cards, see page 12. 

Print to a photo ID badge printer: 

1. Select Administration : People. 

2. Search for the person whose photo ID you want to print. 

3. Click the Photo ID button to display the Photo IDs pop-up window. 

NOTE: If the window does not appear, turn off the pop-up blocker or add the Network 
Controller site to the allowed site list. 

4. In the Photo IDs window, click Print Photo ID. 

5. Verify that the photo ID badge is properly printed. 

Queue photo ID badge requests for printing later: 

1. Click Close. 

2. In the Photo ID tab of the Personal Information page, click to put a check in the 
Request Photo ID box. 

3. Scroll down the page and click Save. 

4. Select Administration : Reports : People : Photo ID Requests. 

5. Verify that the Photo ID Requests report contains a record for the photo ID badge 
print request. 

Print photo IDs from the queue: 

1. Select Administration : Reports : People : Photo ID Requests. 

2. In the Action column click the printer icon. The Photo ID window appears. 

3. Click Print Photo ID and Close. The Print dialog box appears. 

4. Select the Photo ID printer from the Name drop-down and click OK. 
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Encoding Magnetic Stripe Cards 
As part of designing a magnetic stripe card in EPI Designer, you can encode fields to be used for 
access control purposes. Although you can also encode fields to be used for other purposes, this 
is not supported by Linear. 

NOTE: Magnetic stripe encoding is supported only in V3.3 build 344 and above of the eMerge 
software. 

Encode a card with fields to be used for access control: 

1. Select Layout Properties from the Edit menu to open the Layout Properties dialog. 

2. On the General page, click the Encoding button to open the Card Encoding dialog. 

3. Select Track 2 from the Tracks drop-down. 

4. Click the Add Field button and enter “facilitycode” data as the first field and “cardid” 
as the second field, as shown in the following figure. 

5. Click OK. 
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Encode a card with fields to be used for purposes other than access control: 

1. Select Layout Properties from the Edit menu to open the Layout Properties dialog. 

2. On the General page, click the Encoding button to open the Card Encoding dialog. 

3. Select Track 1 or Track 3 from the Tracks drop-down. 

4. Click the Add Field button and enter the fields you want to encode. In the following 
example, U-Field1 has been added. 

5. Click OK. 

 

 

Specify page setup properties: 
1. Select Page Setup on the File menu. 

2. On the Name drop-down, select the default printer to be used for printing badges. 

IMPORTANT: This printer must be specified as the default printer in the badge 
design and in the Windows Printers and Faxes dialog box. To ensure that the printer 
default is set correctly, the default printer selection must be made on the same 
computer as the one used to print badges. 

3. Click the Properties button to open the Printer Properties dialog. 

4. Select the card Orientation: Portrait or Landscape. If there is a Card Type option, 
specify the card type. 

IMPORTANT: The same Orientation setting must be selected for the printer in the 
Windows Printer and Faxes dialog box. 
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Creating a Magnetic Stripe Card Format for Printing 
NOTE: Magnetic stripe encoding is supported only in V3.3 build 344 and above of the 
eMerge software. 

When creating a magnetic stripe card format for printing in the Security Application, you should 
be familiar with the following terms related to the ABA Track 2 format: 

• Start Sentinel (SS): One-byte character (a semicolon “;”) indicating 
where the card format starts. 

• Facility Code (FC): Number found at the beginning of the card format. 
The number is the same for all cards in this 
format. 

• Field Separator (FS): One-byte character (an equal sign “=”) that always 
goes between the facility code and the encoded 
number. 

• Encoded Number (EN): Number that is unique to each card. 

• End Sentinel (ES): One-byte character (a question mark “?”) 
indicating where the card format ends. 

• Longitudinal Redundancy Check (LRC): One-byte character used to verify the input 
internally to the magnetic stripe reader. 

The start sentinel, field separator, end sentinel, and longitudinal redundancy check are always 
part of the card format when you are printing cards in the Security Application. A sample format is 
shown in the following figure.  

 

 
 

Notice that the fifth byte is blank. This is required when printing magnetic stripe formats in the 
Security Application. This byte will become the field separator between the facility code and the 
encoded number. 
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Determining the Length of the Card Format 
Given that the start sentinel, field separator, end sentinel, and longitudinal redundancy check are 
part of the card format by default, the Track 2 format always has four bytes to begin with. The 
remainder of its length is determined by the lengths of the facility code and encoded number. 
Therefore, the length of the card can be calculated with the following formula. 

4 + (Length of FC) + (Length of EN) = Total card format length. 

In the example above, the facility code is three digits long and the encoded number is five digits 
long. Using the formula, you can calculate a card length of 12: 

4 + 3 + 5 = 12 

Printing Magnetic Stripe Encoded Cards 
This section describes how to print photo ID cards in the Security Application. 

Print to a photo ID badge printer: 

1. Select Administration : People. 

2. Search for the person whose photo ID you want to print. 

3. Click the Photo ID button to display the Photo IDs pop-up window. 

NOTE: If the window does not appear, turn off the pop-up blocker or add the Network 
Controller site to the allowed site list. 

4. In the Photo IDs window, clear the Use Default Printer check box, and then click the 
Print Photo ID button. 

5. In the Card Printer Encoder Setup dialog box, shown below, do the following: 

a. Select the name of the printer you want to use from the Printer Name drop-down. 

b. Select the printer manufacturer from the Current Magstripe Encoder list. 

c. Click OK. 

6. Verify that the photo ID badge is properly printed. 
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